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Chapter 1 Using This Manual

This Manual contains information for the PRO-8CW-35SM which is an OTDR, CWDM Channel Analyzer, 
Broad Band Power Meter, Stable Light Source, Visual Fault Locator and Video Scope contained in one 
unit. The beginning of the manual contains general information pertaining to the physical features of the 
equipment. Please refer to the appropriate chapters for information on the operation of each individual 
function.

There are warnings, cautions and notes annotated through this manual.

Warning
A warning alerts to situations that could cause personal injury.

Caution
A caution alerts to situations that may cause damage to the equipment or produce poor testing 
conditions resulting in inaccurate test results.

Note
A special annotation that will assist the user with operational features.
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Chapter 2 Safety

Chapter 3 of this manual is a quick start guide. Prior to using the quick start guide or operating the 
equipment in any way, it is highly suggested the user reads all safety information

This product has been designed and tested in accordance with the Manufacturer’s safety standards, and 
has been supplied in a safe condition.

This document contains information and warnings that must be followed by the user to ensure safe 
operation and to maintain the product in a safe condition. Failure to follow these safety warnings, can 
result in damage to the instrument or harm to the user.

Warning
Personnel should always be aware when working with fiber optic test equipment that active fibers 
may be present and therefore infrared optical energy may be present.

Warning
Never look directly into the end of a connected fiber optic cable or fiber optic adapter of test 
equipment, to do so could expose the user to laser radiation and could result in sever personal injury.

Warning
To Prevent Fire or Shock Hazard

● Do not install battery types other than those specified by the manufacturer

● Do not use the charger without the batteries installed

● Do not expose the battery charger to rain or excessive moisture

● Do not use the AC adapter when there are signs of damage to the enclosure or cord

● Ensure that you are using the correct charger for the local line voltage

● Do not use any other charger than the one provided with this instrument
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Failure to follow these cautions statements may void the warranty of this equipment.

Caution
Fiber-optic connectors are easily contaminated or damaged. The connection to the PRO-8CW-35SM 
is a physical contact type of connection and dirty or damaged connectors may impair the instruments 
capabilities at minimum and at worst result in the need to return this unit to the factory for expensive 
repairs. Prior to making any connection to the unit, ensure that all proper cleaning procedures have 
been followed. Use UPC Finish Connectors Only!

Caution
The PRO-8CW-35SM-CWDM maximum power per channel is +5dBm and the Maximum Composite 
power is +23dBm. Attempting to test greater power levels will cause damage to this instrument.

Chapter 2 Safety



Tel: (888) 545-1254      •      Fax: (415) 358-4602      •      Email: Sales@PrecisionRatedOptics.com
www.PrecisionRatedOptics.com 4

Chapter 3 Introduction

Thank you for purchasing the PRO-8CW-SM35 multi-tasker, the world’s first handheld test and 
measurement product dedicated to assist you with installation, commissioning and maintenance of the 
next-gen fiber optic networks. If you’re working with upgrading an overburdened network with additional 
optical channels or installing the latest generation of multichannel high bandwidth fiber links, the multi-
tasker will assist with meeting your test and measurement needs quickly and efficiently.

The PRO-8CW-SM35 includes the latest extended dynamic range, high resolution Optical Time Domain 
Reflectometer (OTDR) technologies as the base platform. As with all of PRO’s newest developments, we 
have incorporated the standard features including Instant-on, autotest and immediate event analysis for 
fast and trouble free visibility of network distance and loss measurements. Also this instrument includes 
the standard capabilities of the stabilized singlemode light source with autowave capability, the matching 
autowave broadband power meter to complete the Loss Test Set (LTS) function, a visible fault locator 
(VFL) source for nearby fault isolation and fiber identification, and the video scope option for end face 
analysis. New to the PRO-8CW-SM35 is the inclusion of the 8 channel ITU grid multi spectrum (OSA) 
power analyzer for simultaneous measurement of the upper 8 CWDM wavelengths utilized in the latest 
high bandwidth networks.

The multi-tasker provides a startup menu to select from the OTDR, VFL, LTS, SCOPE, and OSA function 
immediately upon energizing. This feature is coupled to each instrument for immediate analysis of 
important features of your link. Before connecting the instrument to your fiber under test, it is good 
practice to examine the optical patch connectors with the optional high resolution 200x or 400x video 
scope probe and collect an image to attach to your link documentation. For basic link analysis the OTDR 
can then be connected and an autotest can immediately provide link loss and distance results on single 
mode fiber at the popular 1310nm and 1550nm wavelengths. The construction mode can be selected to 
automatically collect and file both fiber signatures.

The on-board Loss Test Set completes the standard package of documented results necessary to 
commission a system, or can be utilized for pass fail analysis of network power throughput. The 
advanced autowave feature is a must to improve the efficiency and reliability of measuring at both 
1310nm and 1550nm radiation, but as a broadband power meter it is calibrated for system end to end 
loss analysis at all popular fiber optic wavelengths with your sources.

For commissioning or troubleshooting a multi-wavelength system, the 8 channel CWDM can be utilized 
at various points to detect proper power levels from each source and appropriate add/drop connectivity 
settings at each adjustable node on the network. The channel analyzer provides immediate real time 
power measurement results of all 8 channels from 1471nm to 1611nm simultaneously and also analyzes 
and displays statistical measurements at each ITU grid channel. Of course documentation of all these 
results is accomplished at the push of a button.

PRO has many advanced measuring instruments for use with multiple wavelength multimode and 
singlemode systems from CWDM wavelength OTDR analyzers, DWDM MiniOSA devices, DWDM Tunable 
Laser sources, Variable Optical Attenuators, Loss Test Sets, Video Scopes, as well as PON OTDRs with 
1625nm active out-of-band coverage. Please enjoy the use of your new PRO-8CW-SM35 multi-tasker, and 
again thank you for considering PRO. Please follow the next section’s simple startup instruction to get 
right to work with your PRO test and measurement equipment.
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Chapter 4 Quick Start Guides

4.0 Quick Start Guides

4.1 OTDR Quick Start Guide

Press  to turn on the OTDR.

The OTDR function will be highlighted. Press  to initiate the OTDR application. Connect the fiber to 
the appropriate port. (Select Multi Mode or Single Mode if OTDR is a quad wavelength unit)

Press  to enter the Menu mode.

Use the Scroll Wheel to highlight the [ λ ] in the icon list.

Press  to cycle to the desired wavelength. The OTDR will start a scan at the parameters displayed. If 
approximate fiber length is not known:

Press the  button after selecting the wavelength, (Press  on Range Finder) the Auto Test feature 
will start and set an appropriate pulse width and range automatically. If approximate fiber length is 
known:

Press  and scroll to:

Press  to cycle through the averaging times of - R/T for real-time, Short for a 10 second 
average time or Long for a 5 minute averaging time.

Press  to cycle through the pulse width - select 2m for fibers up to 4 kilometers, 10m or fiber 
up to 16 kilometers, 100m for fibers up to 64 kilometers or 1k for fibers up to 240 kilometers.

Press  to toggle between to available range settings.

Press  to exit the menu mode.

To manually start a scan: Press  while the unit is idle.

To stop a scan: Press  while the unit is scanning.

To view the Event table:
Press  to enter Menu mode and use the Scroll Wheel to 

highlight the Show Event soft key and press the  button to 
change to the event analysis mode
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Chapter 4 Quick Start Guides

4.2 CWDM Channel Analyzer Quick Start Guide

Press  to turn on the PRO-8CW-35SM

Using UPC finish connectors only, connect the fiber to be tested to the “CWDM Optical Port” and press 
the  button to start a scan.

Note
There is an activity indicator in the bottom left of the display, (see figure.8.3) When the indicator is 
red, the unit is ready to scan, to start scanning, press the Scan button. When the Channel Analyzer is 
scanning, the activity indicator will be green

The number of channels displayed may be limited by using the Span Start , Span End  or 
Span Zoom  features. These features are fully described in section 8.4 of this manual.

Note
Scale Minimum Power and Span Minimum power are not applicable on the PRO-8CW-35SM-CWDM 
Channel Analyzer.
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4.3 Loss Test Set Quick Start Guide

Press  to turn on the OTDR.

Use the Scroll Wheel to highlight the LTS function icon and press .

Connect a properly prepared reference cord to the power meter port and the light source port. (If the 
unit is a quad wavelength unit, ensure the proper port is connected)

Press  and use the Scroll Wheel to highlight the Source soft key at the top left of the display.

Press  to energize the first wavelength. Once stabilized, use the Scroll Wheel to highlight the 

icon on the right side of the display. Press  to set the reference for that wavelength. If a second wave 

length is going to be tested, scroll back to the Source soft key and press  to cycle to the next desired 
wavelength and repeat the step to set the reference.

Press  to exit the Menu mode

To conduct a Manual Test

If using the OTDR as the light source, perform 
reference procedure as above and place fiber 
under test in line between the reference cord 
and the power meter port. Ensure you are in 
Menu mode and Scroll to Source soft key.

Press  to cycle through the wavelengths 
and choose the wavelength to be tested.

Press  to exit Menu mode.

Press  to store the measurement to the 
location indicated in the bottom left of the 
display

To conduct an Auto Test

Note: Setting a reference in Auto Test mode is 
not necessary. The source is modulated and a 
Reference of -3dBm (-6dBm-1625) is assumed.

Connect fiber to be tested, press the 
button and the light source will cycle to test each 
wavelength, the power meter will read the signal 

and hold test in temporary memory until the  
button is pressed and the test is stored into the 
memory location indicated at the bottom left 
corner of the display.

Ensure that the unit has cycled through all the 
desired wavelengths prior to pressing the select 
button.

Auto Test will be displayed at the bottom of the 
display to indicate the Auto Test Mode.

Chapter 4 Quick Start Guides
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Chapter 5 Preparation For Use

5.3 Inspection

Before shipment, this instrument was inspected and found to be in perfect working order and  
free of defects.

The shipping carton contains the following:

1. Hand Held OTDR/OSA, with protective boot and 8-AA NiMH batteries installed

2. Universal AC/DC charger with interchangeable mains

3. USB cable

4. Manual on CD with Windows™ compatible software and user’s manual

5. Set of interchangeable adapters, SC and FC, for each OSA port.

5.2 Identification and Configuration

The instrument’s Model/Part Number, Serial 
Number and Date of Manufacture are indicated on 
a label located on the bottom plate of the unit. The 
instrument’s history is filed at the factory by model/
part number and serial number.

5.3 Power Requirements

The PRO-8CW-35SM is equipped with a 100-240V-0.4A input and 13.6V, 0.75A, center positive output 
universal AC/DC battery charger. This charger is supplied with interchangeable mains for US, Great 
Britain, Europe and Australia The unit is shipped with 8-AA NiMH batteries (2700mA hours). Depending 
on usage, fully charged battery pack will typically enable approximately 8 hrs. of use. Fully discharged 
batteries require 6 - 8 hours of recharging.

Fig 5.1
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5.3 Power Requirements (Continued)

Battery replacement is not recommended; however, if you must replace the batteries, follow this 
procedure. Unplug external power supply and ensure the unit is turned off. Carefully remove unit from 
protective boot and remove the two screws from top plate and bottom plates that retain the back cover. 
Carefully remove back cover and remove the two screws that hold the battery covers in place. Replace 
only with 8 high quality AA NiMH batteries. Do not use batteries that are rated at less the 2500mAh. If 
you install NiMH batteries that are dead or less than 1 volt each, charge these batteries for one (1) hour 
before using the unit. For maintenance, batteries require a monthly periodic recharge.

Warning
To Prevent Fire or Shock Hazard:

● Do not install battery types other than those specified by the manufacturer

● Do not use the charger without the batteries installed

● Do not expose the battery charger to rain or excessive moisture

● Do not use the AC adapter when there are signs of damage to the enclosure or cord

● Ensure that you are using the correct charger for the local line voltage

● Do not use any other charger than the one provided with this instrument.

Failure to follow these caution statements may void the warranty of this equipment.

Chapter 5 Preparation For Use
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Chapter 6 Description

6.1 Instrument Description

Instrument Enclosure
The FTE7800 is packaged in a rugged aluminum housing which is further protected with a rubberized 
boot. Although the front panel is weather resistant, care must be taken to avoid liquids and contaminants 
around the fragile optical and electrical connectors, and the glass display. Use a mild cleaning agent 
and damp soft cloth to clean up the panels and the outside case. See the maintenance section to clean 
the optical connector. NEVER open the instrument for cleaning. Return to the factory for servicing if 
necessary.

Display
This units is equipped with a 4” color TFT display

Key Pad
The FTE7800 is equipped with a 7 button key pad. For a full description of functions, please see the 
section of the manual that is dedicated to function being operated.

Scroll Wheel
The scroll wheel is used to navigate through menus, move cursors and make adjustments to settings

6.2 Physical

Front Panel

Display

Key Pad

Charge Indicator

Scroll Wheel

Fig 6.1
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Top Plate CWDM PORT       Power Meter PORT

VFL PORT OTDR Port

Bottom Plate

Power Jack

Video Probe Port

USB Flash

USB PC Port

Fig 6.2

6.3 Home Screen

Visual Fault 
Locator Button

Loss Test  
Set Button

Optical Time Domain
Reflectometer Button

Optical Spectrum
Analyzer Button

Version Number

Video Scope Button

Battery Level  
Indicator

Fig 6.4

Chapter 6 Description

Fig 6.3
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6.3 Icon Definitions

6.3 Icon Definitions

The list below and on the next page contain the icons found on the PRO-8CW-35SM units. They control 
features and functions, and allow the user to set testing parameters. This table gives the name and a 
brief explanation of each. More detailed explanations will be found in later sections of this chapter and in 
chapters to follow.

Setup Icons

Date/Time Used to set the time/date

Back Light Toggles on and off the back light

Speaker Toggles on and off the speaker

Baud Rate Used to manually set the baud rate for USB/PC communications

Home Returns the user to the Home Menu

OTDR Icons

Help Feature Accesses the help files

LSA Adjustments Used to adjust the LSA splice loss areas

File Management Used to enter the File Management

Tool Box The Tool Box contains equipment features, and operational 
parameters that are seldom changed

OTDR Toolbox Icons

Resolution Used to set the OTDR to Low or High Resolution

Unit of Measure Use to set the Unit of Measure to Kilometers, Kilofeet or Miles

Cursor Lock Used to Lock the “A” and “B” cursors movement

Loss Mode Used to Select Splice or LSA loss modes or to disable the loss mode

Calibration This is reserved for factory use

Chapter 6 Description
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6.3 Icon Definitions (continued)

OTDR Icons (continued)

Index of Refraction Used to set the Index of Refraction from 1.024 - 2.048

Lambda Cycles through the wavelengths available for use on the OTDR

Average Cycles through the average mode available

Pulse Width Cycles through the available pulse with for a selected range

Range Cycles through the available ranges on the OTDR

Home Returns the user to the Home Menu

   
Battery Icons Indicates the charge status of the batteries. When operating on AC 

power, an AC plug will be displayed next to the battery.

Channel Analyzer Icons

Help Feature Accesses the help files

File Management Used to enter the File Management

Lambda Used to change channel measurements to wavelength or 
frequency

Home Returns the user to the Home Menu

Calibration This is reserved for factory use

   
Battery Icons 

Indicates the charge status of the batteries. When 
operating on AC power, an AC plug will be displayed next to 
the battery

Chapter 6 Description
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6.3 Icon Definitions (continued)

LTS Icons

Help Feature Accesses the help files

File Delete Delete Loss Test Set files

File Download Download File to the computer via USB cable

Lambda Used to filter power meter wavelengths out of Autotest Mode.

Reference Used to set nonvolatile reference

   
dBm/dB Used to set measurement unit to dBm or dB

Calibration This is reserved for factory use

Home Returns the user to the Home Menu

  
Battery Icons Indicates the charge status of the batteries. When operating on 

AC power, an AC plug will be displayed next to the battery.

Chapter 6 Description
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Chapter 7 General Features and Setup

7.0 General Features and Setup

7.1 General Features

Battery Level/Power Indicator
The bottom right hand corner of the screen shows the battery level indicator. In the final hour of 
operation the battery will change to red. A warning indicator will sound a few minutes before the 
instrument automatically turns off. An AC plug will be displayed next to the indicator bar if the unit is 
operating with the AC power supply/charger. There is also a red charge light in the top right corner of the 
front panel. This will glow red when the unit is charging.

Caution
Ensure the unit is turned off before plugging or unplugging the AC power supply/charger.

USB Flash Drive
Located on the bottom panel is the USB Flash Drive port. Scan file and Scope files may be downloaded 
the external memory device. Screen Shots are downloaded directly to the USB flash drive.

Note
Flash drives of 4 GB or less are supported

USB/PC
Located on the bottom panel is the USB/PC port which may be used to connect the Optical Spectrum 
Analyzer to a computer to download stored data for analysis with the supplied Windows™ compatible 
software.

7.2 Setup Menu

The following features are accessed from the setup menu. To access the setup menu, press the Menu 
button while on the Home Screen. To exit the setup menu at any time press the Menu button again.

Set Date and time
The PRO-8CW-35SM applies a time/date stamp to the saved Scans. The date is configured MM/DD/YY 
and the time is a 24 hour format set in the eastern time zone. To change the data and time, Press the 
Menu button to enter the menu mode, scroll to the Clock icon and press the Select button. The dialog box 
with the settings will be displayed. Use the scroll wheel to change each segment, use the Select button to 
move between segments, and to Save/Redo/Cancel. Use the scroll wheel to select Save, Redo or Cancel 
then press the Select button again to complete setting the date and time. This setting has a memory of 
approximately one month of no instrument activity. To recharge the memory, turn the instrument on for 
5 minutes per month or during the monthly battery charge if the unit is not used for a long period.
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Chapter 7 Features and Preferences

7.2 Setup Menu

Brightness
To set the Back Light press the Menu button to enter the menu mode, scroll to the Tool Box icon, press 
Select and use the scroll wheel to highlight the Backlight icon, press the Select button to toggle the back 
light to Bright or Dim. The status is displayed at the top of the display. Press the Menu button to exit the 
Tools Box.

Sound
To toggle the speaker on or off, press the Menu button to enter the menu mode, scroll to the Tool Box 
icon, press Select and scroll to the Speaker icon, press the Select button to toggle the speaker on and 
off. The status is displayed at the top of the display. Press the Menu button to exit the Tools Box.

Baud Rate
The Baud rate is set to auto detect for use with the software. If it is necessary to make an adjustment to 
the Baud rate, press the Menu button to enter the menu mode, scroll to the Tool Box icon, press Select 
and use the scroll wheel to highlight the Baud Rate icon. Press Select, use the scroll wheel to make a 
selection, press Select again and the unit will exit to the menu mode and return to the main screen.

Home
Highlight the Home icon and press Select to return to the home page
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Chapter 8 OTDR Operation

8.0 OTDR Operation

8.1 Key Pad

Power button, turns the unit On and Off. 
 (Hold for 1 second)

This key will start a scan or stop the current scan.

This key starts autotest range finder and construction mode scans. The range finder 
checks test conditions and starts a scan at the wavelength selected by the user but allows 
the OTDR to determine the pulse width and range parameters. The AutoTest button is 
also used operate the construction mode. The first time this button is selected in a user 
session, a dialog box will be displayed asking the user to choose between range finger 
and construction mode. If during a user session it is desired to change the value of this 
button, holding it down for greater than one second will recall the selection dialog back to 
the screen allowing the user to change the function of the button.

Toggles between the Trace Mode where the focus of the Scroll Wheel and the Select 
Button are on the active cursor and the Menu mode where the Scroll Wheel moves 
through the Soft Key Menu and the Side Icon Bar.

Toggles between A and B as the active cursors.

Selects the Zoom level, each press increments through the levels of  
1x, 2x, 4x, 8x, 16x and 32x.

While in Trace Mode the Select button will move the “Active” cursor to the next event. 
While in Menu Mode, the Select button actuates highlighted item.

While in Trace/Graph Mode the capacitive scroll wheel moves the A and B cursors. While 
in Menu Mode it highlights soft keys and icons and while in Table Mode it highlights files 
and events

Fig 8.1
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Chapter 8 OTDR Operation

8.2 OTDR Display

Trace display

Trace Measurements

Trace Parameters

Wavelength Setting

Averaging Mode

Pulse Width Setting

Range Setting

Fig 8.4

“A” Cursor “B” Cursor

Measurement Area
(see fig. 8.3 for more detail)

Zoom Status
and Grid Values

Parameter Settings
(see fig. 8.4 for more detail)

Battery Status

Fig 8.2

“A” Cursor
Splice Loss

“A to B”
Distance

dB Loss Per 
Unit of Measure

“B” Cursor
Splice Loss

“A to B”
2 Point Loss

Index Of 
Refraction

Fig 8.3
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OTDR Display with Menu Open

Soft Keys

Menu icons

Fig 8.5

8.3 OTDR Tools Menu

Below is a list of the settings available through the Tools Menu in the OTDR mode. Press the Menu 
button to open the Menu mode, scroll to the Tools icon and press the Select button. Scroll to the desired 
setting and press Select to open.

Resolution
The resolution tool should be highlighted. Use the Select button to toggle between Low and High. This 
resolution feature affects the ranges of 4km and 16km. At low resolution 4km range, data points are 1/4 
meter apart and at high resolution, the data points are 1/8 meter apart. At 16km range, the low resolution 
date points are 1 meter apart and at high resolution the data points are 1/8 meter apart.

Unit of Measure
The distance unit of measure may be either displayed in Kilometer (Km), Kilo feet (Kf) or Mile(Mi). Scroll to 
Unit of Measure icon and use the Select button to toggle between Km, Kf or Mi. Press the Menu button to 
return to the trace display.

Cursor Lock
The cursors may be lock for accurate measurements. To lock the cursors press the Menu button, scroll 
to the Tools icon and press the Select button. Scroll to the Cursor Lock icon and press Select to toggle 
the lock cursor mode on and off. In the lock cursor mode, with the A cursor as the active cursor, both A 
and B cursors move and with the B cursor as the active cursor, the B cursor will move independently in 
order to set the distance between the two cursors
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8.3 OTDR Tools Menu (Continued)

Loss Mode
Loss Mode setting allows the user to set the splice loss measurement to be displayed to either simple 
splice loss, LSA (least squared averaged) or shut off this measurement to limit the amount of information 
on the display.

Splice Loss
Splice Loss method is meant to be used in noisy environments when it is difficult to attain an LSA area 
that lays flat on the back scatter before and after the cursor. See section 8.9 - Setting Splice Loss 
Measurement Areas. This method takes an average of the selected points before and after the active 
cursor and uses this average to make a good estimation of the event loss. This is an estimation but this 
method may be more accurate than LSA Splice Loss method in noisy environments.

Least Squares Approximation (LSA)
LSA Splice loss method gives the user a visual aid in setting splice loss areas. The splice loss lines must 
be set to overlay the backscatter of a trace without over lapping any other events. The LSA areas are set 
properly when the LSA visualization lines overlay the back scatter sections of the trace before and after 
the event. This method can be more accurate by affording the ability to see the slope of the splice loss 
areas, however: it can also supply a reading with greater error if not used properly. Please see Fig 8.7, 
8.8 and 8.9 for examples of LSA settings. In Noisy environments the LSA Lines will have an exaggerated 
movement making the Basic Splice Loss Measurement potentially more accurate. The Splice loss 
measurement may also be disabled if these measurements are not require for testing.

Enter Calibration
This tool is for factory use.

8.4 Auto Test

Warning
Clean connector thoroughly prior to connection to the appropriate port of the OTDR. Failure to 
ensure the connectors used with the OTDR are properly cleaned can result in poor launch conditions 
at the minimum or damage that requires the unit be returned to the factory for repair.

Warning
Before connecting to a patch cord or fiber under test, be certain the fiber has no active optical 
sources or instruments connected to the other end. Skin or eye damage could result from other high 
power sources e.g. EDFAs, or instrument damage could occur voiding the warranty.

Note
The first time Autotest is press upon power-up, a dialog box will be display to set the function of the 
button. Use the scroll wheel to move between the Range Finder and Construction Mode. Press the 
Select button once the desired function is highlighted. To change the function once set in a user 
session, press and hold the Autotest button and the dialogue box will be displayed again.
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Range Finder
This is a useful feature when the approximate length of the fiber to be tested is unknown. The Range Finder 
feature tests at the wavelength selected by the user. To set the wavelength, press the Menu button, scroll to the 
Lambda icon and use the Select button to cycle to the desired wavelength. Press the Autotest button, the unit will 
set the average time to short, starts a scan and flashes Auto in the pulse width and range parameters. When Auto 
stops flashing the unit has set the pulse width and range, then completes the test and displays the trace.

Construction Mode
This is useful when a large number of fibers need to be tested with the same settings at multiple wavelengths. To 
operate in Construction mode, set the Autotest button to construction mode in the manner described above. The 
Construction Mode tests up to two wavelengths at one time, displays the two traces and saves the traces to the 
next two available storage locations.

Follow these procedures to test in Construction mode:

Set Wavelengths:
Set the wavelengths to be tested by pressing the Menu button, scrolling to the Tools icon and pressing Select. 
Scroll to the Set Wavelength Filter tool and press Select. Grayed out wavelengths are turned off. The wavelengths 
in black text are active. To select wavelengths, scroll to highlight the wavelength and press the Select Button. To 
complete the process, scroll to Save and press select. Press Menu again to close the Tools dialogue box.

Set Test Parameters:
Check the Average Time, Pulse Width and Range to ensure they are set properly. Refer to section 8.5 for 
instructions on setting these parameters.

Note: Real Time is not recommended as an averaging time for Construction mode.

Set File Name:
It is necessary to set the base file name prior to starting the test. To establish the file name, press the Menu 
button and scroll to the File Management icon and press Select. Scroll to an empty file location and press Select. 
Name the file by using the scroll wheel to display the desired letter or number and press Select to move to the 
next Character. Do not press select to enter the last character. Once it is displayed, press the Menu button and 
Save Changes soft key will be highlight, press Select or use the Scroll Wheel to select Discard Changes and press 
Select. All future files will use the new base file name until it is change. The file that was just created may be 
deleted if desire by following the procedures in section 10.9.

Set Default Notes:
To enter default notes for trace files, enter the File management as above and scroll to any empty location. Press 
the Menu button, scroll to the Notes soft key and press Select. The first Character of the note box is highlighted. 
Use the Scroll Wheel to select the desired character and press select. Continue on until the note is complete. To 
erase the characters and move forward, use the “blank”. To quickly return to the beginning of a note, press the 
Menu button and then the Select button on the Notes soft key. To exit the Notes box, press the Menu button. This 
note will now be the default note for all traces until it is change
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8.4 Auto Test (Continued)

Conduct Tests:
Connect a fiber to the proper test port and press the Autotest button. The OTDR will conduct the test 
at the first wavelength and store the trace in temporary memory using the base file name given, with 
default notes attached. The second wavelength is then started and once complete the traces stored to 
memory, and then both traces are displayed for review.

Disconnect the fiber, connect the next fiber and press Autotest. The two tests will be completed stored 
and displayed. Continue on until all fibers are tested.

8.5 Manual Scan Settings

After powering on the OTDR, Enter the menu mode by pressing the Menu button and scroll to the 
parameter keys to set all the necessary parameters to the appropriate values. These parameters include:

Resolution
Enter the Menu mode, scroll to highlight Tools icon and press Select. The resolution tool should be 
highlighted. Use the Select button to toggle between Low and High. This resolution feature affects 
the ranges of 4km and 16km. At low resolution 4km range, data points are 1/4 meter apart and at high 
resolution, the data points are 1/8 meter apart. At 16km range, the low resolution date points are 1 meter 
apart and at high resolution the data point are1/8 meter apart.

Note
The resolution setting does affect speed and internal storage capability. At the 16km range, high 
resolution vs. low resolution, the trace could take up to 8 times longer to complete and trace file sizes 
could be up to 8 times larger, decreasing file storage capability. High resolution mode at the 4km 
range could cause the trace time to double as well as the file size. To determine the amount of trace 
memory available, enter file management, scroll to the view tab and select “Stats” from the drop down 
menu. This will show the number of traces saved and the number of traces that can still be saved in 
the internal memory.

Note
To determine the amount of trace memory available, enter file management, scroll to the view tab and 
select “Stats” from the drop down menu. This will show the number of traces saved and the number 
of traces that can still be saved in the internal memory.

Index of refraction (IOR)
It is necessary to have the Index of Refraction set as close as possible to the actual IOR of the fiber. 
If this is unknown it is best to use the default setting on the OTDR. To change the IOR, highlight the 
IOR icon and press the Select button. Use the Scroll wheel to change the IOR value. When the desired 
value is reached, press the select button again and the OTDR will prompt the user to save or cancel the 
changes. Use the scroll Wheel to highlight desired action and press the Select button.
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8.5 Manual Scan Setting (Continued

Wavelength
Use the scroll wheel to highlight the Lambda key, press select to cycle through the available wavelengths.

AVG
Use the scroll wheel to highlight the Average (AVG) icon and use Select button to cycle through, Real-time 
averaging, with a up to 2 pps refresh rate, Short average (~30 seconds) or long average (~10 minutes). 
Changing this setting will also initiate a scan.

Pulse Width
Use the scroll wheel to highlight the PW icon and use the Select button to cycle through the available 
pulse widths for the selected range. The pulse widths are listed in the table below.

Range
Use the scroll wheel to highlight the RNG icon and use the Select button to choose the desired range. 
Available ranges are listed in the table below.

8.6 Viewing a Trace

Zoom
There are five zoom levels, 1x, 2x, 4x, 8x, 16x and 32x. The current level is indicated in the bottom right 
corner of the display with the values per division. Press the Zoom button to cycle through the zoom 
levels. When in the Menu mode, pressing select while the Zoom soft key is highlighted will also cycle 
through the zoom levels.

5ns 10ns 30ns 100ns 300ns 1µs 3µs 10µs 20µs
1km

4km

16km

64km

256km

Pulse Width

R
an

ge

Fig 8.6
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8.6 Viewing a Trace (Continued

Note
The values per division change with each change of the zoom level and are indicated in the lower right
corner of the display

Zoom Bar
The bottom most portion of the trace is a Zoom Bar. This represents the entire range of the trace being 
viewed. The green bar within the area represents the amount of the trace that is being viewed whiled 
the zoom function. While in Zoom level 1x the green bar will fill the zoom bar area meaning the entire 
range of the trace can be viewed and in Zoom level 2 the green bar will fill only half of the zoom bar area, 
meaning half of the entire range of the trace can be viewed. As the zoom levels increase, the green zoom 
bar will decrease in size to indicate the amount of the trace that can be views at one time. As a cursor 
is moved with the Scroll Wheel, the green zoom bar moves to indicate what portion of the trace is being 
seen. For example, if the green bar is to the left of the zoom Area, the beginning portion of the trace is 
being viewed and if the green bar is to the right of the zoom Area, the end of the trace is being viewed.

Cursor movement
The active cursor is shown as a solid line while the inactive cursor is a dashed line. When in the Menu 
mode an “A” or “B” will be displayed next to the Cursor soft key as in indication Press the A/B button 
to toggle between the cursors. When in the Menu mode, pressing select while the Cursor soft key is 
highlighted will also toggle the active cursor.

Cursor Lock
The cursors may be lock for accurate measurements. To lock the cursors press the Menu button, scroll 
to the Tools icon and press the Select button. Scroll to the Cursor Lock icon and press Select to toggle 
the lock cursor mode on and off. In the lock cursor mode, with the A cursor as the active cursor, both A 
and B cursors move and with the B cursor as the active cursor, the B cursor will move independently in 
order to set the distance between the two cursors.

Note
To quickly move the active cursor to the next event, press the Select button while the unit is in the 
trace view mode.
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8.7 Unit of Measure

The distance unit of measure may be either displayed in Kilometer (Km), Kilo feet (Kf) or Mile(Mi). To 
change the setting, enter the menu mode, scroll to highlight the Tools icon and press the Select button. 
Scroll to Unit of Measure icon and use the Select button to toggle between Km, Kf or Mi. Press the Menu 
button to return to the trace display.

8.8 Loss Measurements

2 Point loss
2 Point loss method takes the difference in vertical height between where the A and B cursors cross the 
trace to determine the amount of loss in that section of fiber.

dB/Km
The dB/Km (dB/Kf) loss method takes the 2 Point loss in dB and divides by the distance between the 
cursors in Kilometers (Kilo feet). For accurate dB/Km (dB/Kf) loss measurements, the two cursors must 
be on level backscatter points at least 100m apart (NA will be shown for distances that are too short).

Splice Loss
Splice Loss method is meant to be used in noisy environments when it is difficult to attain an LSA area 
that lays flat on the back scatter before and after the cursor. See section 7.8 - Setting Splice Loss 
Measurement Areas. This method takes an average of the selected points before and after the active 
cursor and uses this average to make a good estimation of the event loss. This is an estimation but this 
method may be more accurate than LSA Splice Loss method in noisy environments.

Least Squares Approximation (LSA)
Least Squares Approximation (LSA) Splice loss method gives the user a visual aid in setting splice loss 
areas. The splice loss lines must be set to overlay the backscatter of a trace without over lapping any 
other events. The LSA areas are set properly when the LSA visualization lines overlay the back scatter 
sections of the trace before and after the event. This method can be more accurate by affording the 
ability to see the slope of the splice loss areas, however: it can also supply a reading with greater error if 
not used properly. Please see section 8.9 for examples of setting LSA areas. In Noisy environments the 
LSA Lines will have an exaggerated movement making the Basic Splice Loss Measurement potentially 
more accurate
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8.9 Setting Splice Loss Measurement Areas

The splice loss measurement areas around the cursors are adjustable. This feature is used for both 
Basic Splice Loss and LSA Splice Loss. To access this feature, press the Menu button and scroll to the 
SPL icon. An arrow will be displayed above the point of the measurement area to be adjusted with the 
Scroll Wheel. There are three points that may be adjusted. The left hand most point of the measurement 
area before the cursor and the left or right hand point of the area after the cursor.

LSA Set Too Early

LSA Set Too Late

The LSA area and cursor are set 
too early. The right most green 
LSA indicator line is not over 
laying the back scatter of the 
trace properly

The LSA area and cursor are set 
too late. The left most green LSA 
indicator line is not over laying 
the back scatter of the trace

Proper LSA Setting

The LSA area and cursor 
are set properly. The green 
LSA indicator line is over 
laying the back scatter of 
the trace properly.

Fig 8.7

Fig 8.8

Fig 8.9
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8.10 Quick Save/Recall

Quick Save
To use quick save, press the Menu button, scroll to the Save soft key and press the Select button. The 
trace will be saved to the storage location shown. The file will be stored with the same base file name 
as the last save stored trace. If the storage location indicated already contains a file, the user will be 
prompted to either “Overwrite” the location, Save to the “Next” available location or “Cancel” the action. 
Scroll to the desired action and press Select. The storage location will increment accordingly.

Note
There are sample traces stored on the OTDR at the factory. These traces are saved in the with the 
base file name of default.

Quick Recall
To quickly recall a trace, press Menu, scroll to the Recall soft key and press the Select button to display 
the trace that is saved in the memory location indicated and the next memory location with a trace will be 
displayed
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Chapter 9 Event Analysis

9. 0 Event Analysis

NOTE
When using the event table, it is necessary to keep in mind that event analysis provides approximate 
loss and distance measurements to quickly assist in network evaluation. Automatic detection results 
are not guaranteed and have their limits, possibly causing erroneous readings or detection failure. 
User interaction by interfacing with the trace display is recommended for final qualitative and 
quantitative analysis.

9.1 Enter Event Analysis Mode

To open the event analysis table, press the Menu button, scroll to highlight Show Event soft key and 
press the Select button. Use the Scroll Wheel to move through the events. If the Select button is pressed 
while an event is highlighted, The OTDR will revert to the Trace Screen with the active cursor positioned 
at the selected event. An alternative method to return to the trace view is to press the Menu button, 
scroll to the Show Trace soft key and press the Select button.

9.2 Event Analysis Table

Fig 9.1
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Event Number
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9.3 Field Descriptions

# (Event Number)
Indicates the events in sequence, higher numbers are further distances from the OTDR. “E”, which is 
always displayed in the bottom row is the event determined to be the End of Fiber (EOF).

P/F (Pass/Fail)
Pass/Fail, if any one of the thresholds are not met for and event, the P/F column will display a red X. The 
parameter that failed will also be displayed in red. If all the parameters are met, a green check mark will 
be displayed.

KM (Event Location)
Event Location, Km for Kilometer or KF for Kilo-feet or Mi for Mile. This is the distance/location that the 
event occurs in the respective unit of measure. Field Descriptions (Continued)

SPLICE (Event Loss)
Event Loss, where a positive number is the amount of loss and a negative number would be indicating a 
gain. This is a set-able threshold for the Pass/Fail feature.

2POINT (2 Point Loss)
Point Loss, which is measured from the end of the dead zone of the previous event to the beginning of 
current event.

DB/KM (dB Loss Per Km/Kf)
dB per Kilometer if in KM unit of measure and DB/KF if in Kilo-Feet unit of measure. This is the calculated 
loss per Km or Kf from the end of the dead zone of the previous event to the beginning of the current 
event.

TYPE (Event Type/ORL)
Event Type is the type of event or the ORL measurement. If the event is no reflection, “splc” will be 
displayed and if the event contains a reflection, the ORL value will be displayed. This is a set-able 
threshold for the Pass/Fail feature

E (End Event)
The bottom row of the table is the loss and distance information as it pertains to the entire fiber link. KM 
column is the end of fiber distance measurement, Splice column is not used, 2 Point is the measurement 
from the origin (OTDR) to the determined end of fiber in the KM column. The dB/km column is that 
measurement for the entire link and in the Type column Link will be displayed
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9.4 Event Sensitivity Level

There are three levels of sensitivity while in the event table. The sensitivity is set via the Sense soft key. 
Press the Menu button and Scroll Wheel to highlight the Sense key. Press the Select button to cycle 
through “Lo” (Low) for event with loss as low as approximately 0.5dB, “Me” (Medium) with events with 
loss down to approximately 0.2dB and “Hi”, for events with loss as low as approximately 0.1dB. Medium 
and High sensitivity settings should be used for high signal level, low noise, long pulse, averaged traces.

9.5 Pass/Fail Settings

Splice, ORL and Link are all settable thresholds for Pass/Fail purposes. To set the thresholds, press the 
Menu button, scroll to highlight the desired soft key, press the Select button and use the Scroll Wheel 
to reach the desired value. Press Select button again to lock in the settings. If the trace fails any of the 
three thresholds, a red X will be displayed in the P/F column and the suspect threshold value will be 
displayed in red.

Examples:

Splice:	 If a splice needs to be less then 1dB, set the threshold to <1.0. If 1.0 would 
		  be accepted, set threshold to 1.01db.

ORL:	 If an ORL needs to be less then -50dB, set the threshold to <50. If 50dB is acceptable, 
		  set the threshold to <49.

Link:	 If the link loss needs to be less then 20dB, set the threshold to <20. If 20db link 
		  loss is acceptable set the threshold to <21.

End:	 This threshold setting is the first test to determine the end of fiber. If set to 3dB, 
		  the first event that meets this threshold will be identified as the end of fiber.

To return to trace view, press the Menu button, scroll to the Show Trace soft key  
and press the Select button.
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10.0 File Management

10.1 Display

Chapter 10 File Management

File Management Drop Down Menus

Fig 10.2

10.2 Entering/Exiting File Management

Press the Menu button, scroll to highlight the TRC (Disc) icon and press the Select button. For each test/
file saved, an indication of wavelength, range, pulse width and a time stamp are stored. The file name 
can have up to 16 characters using the following; 0-9, A-Z, a-z, _ (underscore) or blank. To close the File 
Management System, press the Menu button, scroll to highlight the File Tab, scroll to Exit and press 
Select.

10.3 Saving a Trace

There are two methods to save traces. The first is the Quick Save method described in section 8.10 The 
second method is to enter file management with a trace on the display, press the Menu button, scroll to 
the File Management icon and press Select. Press the Menu button to the shift the focus of the scroll 
wheel to the file management tabs. Highlight the File tab, press Select and with Save highlighted in the 
dropdown menu, press select again. Use the scroll wheel to change the highlighted character. With 
the desired character displayed, press Select to enter that character and the next character will be 
highlighted. Continue until the desired file name is entered and press the Menu button. Use the scroll 
wheel to highlight Cancel, Redo or Save and press Select.

File  
Management  

Tabs  
See Fig 9.2

Context 
Sensitive Help

Default Notes

File Name

Wavelength

Range

Pulse Width

Time Stamp

Fig 10.1
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Chapter 10 File Management

10.4 Renaming a Trace

Highlight the file to be renamed using the scroll wheel. Press the Menu button and scroll to highlight the 
Edit tab. Press Select and with Rename highlighted in the drop-down menu, press select again. To leave 
a character unchanged, simply press Select on the highlighted character. To change a character, use the 
scroll wheel to make the change and press select with the desired character displayed. Continue until the 
name is entered, press the Menu button, scroll to select Save Changes or Discard Changes, and press 
Select.

10.5 Viewing Saved Trace

To view a saved trace from internal memory, use the scroll wheel to highlight the desired trace and press 
the Select button. The OTDR will revert to the trace view with the selected trace displayed and directly 
below the trace will be the trace name. “Load” located in the File dropdown menu may also be used to 
load a trace to the trace screen. With the desired trace highlighted, press menu, scroll to the File tab, 
press select, use the scroll wheel to highlight Load and press Select.

10.6 Dual Trace

Note
To compare two traces, they must have the same range and resolution settings.

With a trace on the display, enter the file management, highlight the trace to be placed in the background, 
press the Menu button, scroll to the File tab highlighted, press Select, scroll to Dual on the drop-down 
menu and press select again. Both traces will now be displayed. The primary or first trace loaded is the 
black trace and the secondary trace is the green trace. All values displayed are the values associated 
with the primary trace. If the trace for the background does not have the same range or resolution as the 
main trace, a range mismatch message will be displayed. Press the Select button to clear the message.

To exit the Dual Trace mode, start a new scan or open a new main trace from file management.

10.7 Marking Traces for Mass Coping and Deleting

Scroll to highlight the first trace to be copied or deleted. Press the Menu button, scroll to the Mark tab 
and press Select. To mark 1 or 2 files for mass copying, press the Select button and the highlighted trace 
will be displayed in red font. Pressing select again will mark the highlighted trace and the next trace will 
be highlighted. (The highlighted file is not marked.) Only those files in displayed in red are marked. To 
mark a large number of files use the scroll wheel. Scrolling down (clockwise) will mark a file and scrolling 
up (counter clockwise) will un-mark a file. Files may be skipped by shutting off the marking feature, 
scrolling ahead and turning the feature back on. To do this, once the last trace of a section has been 
marked, press the Menu button, scroll to the next file to be marked, press Menu again, press Select or 
scroll to continue marking the files. Once all the desired traces are marked they may be deleted or copied 
as necessary.
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10.8 Copying Traces

NOTE
Limit flash drives to 4 gigabytes. It is suggested that new flash drive sticks be tested prior to use. Save traces 
to the flash drive from the OTDR and test them on the computer with the supplied software to ensure they 
operate properly.

NOTE
Do Not Remove USB Flash Device While The OTDR Attempts To Read Or Write To That Port. Traces may be 
copied to the USB flash drive or to a PC for use with the certification software. The Certification Software is 
required to copy trace files to a computer through the USB/PC Port. With a trace highlighted or a group of 
traces marked, press the Menu button and scroll to the Edit tab, press Select, chose either Copy PC or Copy 
USB from the drop-down menu and press select.

10.9 Deleting Traces

Traces may be deleted from the internal memory or USB flash drive. With a trace highlighted or group of trace 
marked, press the Menu button, scroll to the file tab, choose Delete from the drop-down menu with the scroll 
wheel and press Select. Use the scroll wheel to highlight Cancel or Confirm Delete and press Select.

Adding Default Notes
A note may be saved with a trace. With a file highlighted, entering a note will save that note for that one trace. With 
an empty file storage position highlighted, enter a note and this note will be stored with all traces until the note is 
changed or deleted. To enter notes, while in the file management screen, press the Menu button, scroll to the Edit 
tab and press Select. Use the scroll wheel to choose Notes from the drop-down menu and press Select. The first 
character of the notes field will be highlighted. Use the scroll wheel to choose a character and press Select. To 
erase a character or enter a space, scroll back to the “blank” which is the first character available. If a mistake is 
made, it may be best to exit the Note field by pressing the Menu button, and reenter the notes field from the Edit 
dropdown. Once you have completed the note, press Menu to exit.

10.10 Accessing Flash Drive

To access the flash drive, while in file management, press the Menu Button and scroll to the View tab, press Select 
and choose USB Stick from the dropdown menu. To return to the internal memory, press the Menu button, return 
to the View dropdown and choose Internal. All of the Tab functions available for the internal memory are also 
available for the Flash drive.

10.11 Internal Memory Statistics

The amount of storage available in the onboard memory is found in the Internal Memory Statistics screen. To view 
this screen; while in file management, press Menu, scroll to the View tab and select Stats from the drop-down 
menu. This will indicate the percentage of memory used and how many more traces of a specific range may be 
saved.

Chapter 10 File Management
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Chapter 11 Loss Test Set Description

11.0 Loss Test Set Description

11.1 Entering Loss Test Set Mode

The LTS application is entered from the Home Menu. Use the Scroll Wheel to highlight the LTS 
application Tab and press Select. From the OTDR application, press the Menu button, scroll to the Exit 
Icon and press Select to return to the Home Menu. When in the Scope application, Press the Menu 
button, scroll to highlight the Return soft key and press Select to return to the Home Menu.

11.2 Key Pad Operation

Power button, turns the unit on and off.

Resets any temporarily memory values before they have been 
stored with the select button.

Starts the Auto Test function. The light source will be turned on and cycle through the 
wavelengths selected with the λ icon.

Toggles between the Test mode and the Menu mode where the focus of the Scroll Wheel 
and the Select Button are on the soft keys and icons.

Cycles through the power meter wavelengths selected with the λ Icon. When in the File 
Selection Screen this key will toggle through save values for a particular storage position.

Changes the display to the zoom screen where all stored test for a memory location are 
display. There can be up to 4 test stored per location.

The Select Button will store all measurements in the temporary memory to the storage 
position shown the lower left corner of the display while in the Test Mode and while in the 
Menu mode it will activate an icon item or soft key.

The scroll wheel is only used when in menu mode while in Live Scan mode. When in File 
View mode, it is used to move through soft keys and icons in Menu mode and scrolls though 
the stored file when not in menu mode.

Fig 11.1
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11.3 LTS Displays

LTS Live Scan Mode

LTS File View Screen
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11.4 LTS Soft Key Operation

Source
Enter the Menu mode and scroll to highlight the Source soft key. Press the Select button to cycle through 
the available wavelengths. (See Lambda/wavelength icon information below) The displayed source 
wavelength is the active source. Turn off all sources, by cycling to the “Off” position.

Power Meter
Enter the Menu mode and scroll to highlight the Power Meter soft key. Press the Select button to cycle 
through the available wavelengths. (See Lambda/wavelength icon information below)

Mode
Enter the Menu mode and scroll to highlight the Mode soft key. Press the Select button to toggle between 
the Live Scan mode and File View mode.

11.5 Loss Test Set Icon List

Help
The Loss Test Set has an onboard help feature. To access the help feature, enter the Menu, use the 
scroll wheel to highlight the Question Mark Icon and press the Select button. Scroll to the desired topic 
and press the Select button. Press the Menu button again to exit the help feature.

Delete
Deleting a stored loss measurement is accomplished in the File Selector mode. (See LTS File Selector 
operation, Section 11.4) To delete a measurement/s from a single memory location, while in the File 
Selector, select the desired test to be deleted, press menu scroll to the Delete icon and press select

Note
There is not warning or confirmation necessary to delete one memory location.

To delete the all the memory locations at one time, follow the procedure above, however do so on and 
empty location. When the Delete icon is select on the empty location, a Confirm dialog with “Delete all 
files?” will be displayed and the option to Delete or Cancel the action. Press the Select button with the 
desired action highlighted.

Note
A loss measurement of (----) is not empty if there is a wavelength displayed to the right. That would be 
a null measurement). An empty location is (----) with no wavelength displayed to the right.

Measurements may also be deleted in the Quick File Locator. With the storage location selected, press 
the Menu button, scroll to the Delete icon and press Select. There is a time out on the Quick File Select. 
If the display reverts to the test mode, before the delete button is selected, the file will not be deleted

Chapter 11 Loss Test Set Description
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Lambda (Wavelength Selection)
Highlighting and selecting the λ Icon will display the Wavelength Selection menu. Use the scroll wheel to 
highlight the wavelengths to be select for use with the light source and power meter and press the Select 
button to toggle them off and on. The selected wavelengths will be the only wavelengths tested auto test 
and the only ones available when cycling through the light source and power meter soft keys. Highlight 
“Save Selection” at the bottom of the menu and press the Select button to save the setting and return to 
the Loss Lest Set mode.

File Download
File Download is used to send the save Loss Test to a PC. Once the PRO-8CW-35SMA is connected to a 
computer with the certification software running, enter the menu mode and highlight the File Download 
icon. When directed to do so, press the Select button to immediately start a download to the computer 
via the USB cable. Press the Menu button to return to the test mode.

Set Reference
This icon is used to set the reference for relative loss measurements.

dBm/dB
This icon is used to toggle the power meter from absolute power referenced by dBm and relative power 
referenced by dB.

Calibration CAL
This tool is for factory use only.

Exiting Applications
Press the Menu button, scroll to the Home icon and press Select

Chapter 11 Loss Test Set Description
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12.0 Loss Test Set Operation

12.1 Power Meter Measurements

Power Measurements
With the PRO-8CW-35SM in Live Scan, connect the fiber carrying the optical power to be measured to the Power 
Meter detector utilizing the appropriate adaptor. Select the power meter wavelength that matches the wavelength 
of the light being measured. The power reading will now indicate the optical power in units of dBm. The power will 
display an out-of-range condition indicated by a series of four dashes on the display if the signal is greater than +5 
or less than -77 dBm. CATV versions are available upon request. To save the power measurement to the storage 
location indicated below the STORE label press the Select button. The memory location will auto increment to the 
next available memory location.

Relative Measurements
To make a relative power measurement you must first save the reference power level. To store a reference level, 
attach reference cord/s and energize the light source. Enter the Menu mode, scroll to Ref icon and press the 
Select button. The reference is now stored in nonvolatile memory and displayed at the bottom right of the display. 
The units of the display will now change to dB. Subsequent readings will now be displayed in terms of dB relative 
to the stored reference value. A reference memory location is available for each selected wavelength. A reference 
reading is required to change to dB measurement from dBm measurements.

Remove the connector from the power meter port and place the fiber under test inline between the reference cord 
and the power meter port. The reading displayed will be the loss of the fiber under test relative to the reference. 
Ensure the unit is not in Menu mode and press the Select button to store the measurement.

Stored power measurements may be recalled by moving the Scroll Wheel and the File Selector Screen will be 
displayed. If no buttons are press for 5 seconds after entering the File Selector mode, the unit will revert to the 
test mode. The Scan button may also be pressed to re-enter test mode.

12.2 Autotest Mode

To use the Auto Test feature, connect the fiber to be tested to a compatible test set. The unit being used as the 
source should be set to Autotest. If Two Quad OTDRs are being used, only the wavelengths to be tested should be 
selected as sources by entering the Wavelength/Lambda selection menu. Only the wavelengths that are energized 
will be displayed on the power meter end. Once the source and power meter have cycled through the wavelengths 
to be tested, press the Select button on power meter to store the measurements.

Note: A reference measurement is not used in the Auto Test Mode. The Source is modulated and has power 
level of -3dBm (-6dBm@1625). This method of measurement does not take into account the launch condition, 
thus the manual method of testing should be used when highly accurate measurements are required such as 
when testing the loss of an individual connector. The Auto Test annunciator will be displayed during Auto Test 
loss measurements. Two or more loss measurements are best viewed in the Zoom mode where all the selected 
wavelengths will be display at one time on the display.
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12.3 Light Source Operation

The lasers are initially in the off state when the LTS is launched. Enter the Menu mode and use the 
Scroll Wheel to highlight the Source soft key. Pressing Select will energize the available wavelengths in 
sequence.

12.4 File View

Enter the File View by pressing the Menu button, scrolling to the Mode soft key and pressing Select. 
Press Menu to exit the Menu mode. Use the scroll wheel to scroll through the stored traces. The Store 
location in the bottom left of the screen will be changed to VIEW location. The value shown is the data 
stored in the displayed file location. To exit the File View press the Menu button, scroll to the Mode soft 
key and press select.

12.5 File Transfer

To transfer files from the Loss Test Set to the computer, start the certification software. Connect the 
OTDR to the computer with the supplied USB cable, Select Loss Test Set from the applications tabs. To 
start the memory download, enter Menu mode on the OTDR, highlight the File Download Icon and press 
Select. The download progress will be indicated by the UPLOAD counter in the bottom left corner of the 
LTS display and in the top right corner of the software screen.
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Chapter 13 Channel Analyzer Operation

13.0 Channel Analyzer Operation

13.1 Key Pad Operation

Power button turns the unit On and Off.  
(Hold for 1 second)

Scan button starts or stop a scan, and resets the  
table of data.

This button is disabled for 8 Channel CWDM Channel Analyzer.

Menu toggles the focus of the Scroll Wheel between the Scan Mode and the Menu Mode. In 
Scan mode the focus of the Scroll Wheel and the Select Button are on the active cursor. In 
Menu Mode, the Scroll Wheel moves through the Soft Key Menu and the Side Icon Bar.

Toggles between “A” and “B” as the active cursors.

This button is disabled for 8 Channel CWDM Channel Analyzer.

The Select button actuates the highlighted item.

While in Scan Mode, the scroll wheel moves the cursors. While in Menu Mode, the scroll 
wheel is used to move through the soft keys and icons.

Fig 13.1
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13.2 Channel Analyzer Display

Displayed Scan Measurements
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13.3 Enter Channel Analyzer Function

Enter the CWDM Channel Analyzer operation from the home screen by using the scroll wheel to highlight 
the OSA icon and press Select.

Warning
Care should be taken as skin or eye damage could result from high power devices such as 
transmitters or EDFAs.

Caution
The PRO-8CW-35SM Channel Analyzer is designed to test a total power of 23dBm. Attempting to test 
a total power above 23dBm will cause damage to this instrument.

Caution
Fiber-optic connectors are easily contaminated or damaged. The connection to the PRO-8CW-35SM 
is a physical contact type of connection and dirty or damaged connectors may impair the instruments 
capabilities at minimum and at worst result in the need to return the PRO-8CW-35SM to the factory 
for expensive repairs. Prior to making any connection to the unit, ensure that all proper cleaning 
procedures have been followed. Use UPC Finish Connectors Only

Start a Scan
Ensure the connector to be inserted into the optical port of the channel analyzer is clean and not 
damaged. Insert the connector and press the Scan button to start a scan.

The wavelength/frequency and power are shown at the top right corner of the display in blue for the “A” 
cursor and red for the “B” cursor. Just below the power reading for the cursors is the deviation between 
the power levels of the channels selected by the cursors and below that is the total power measurement. 
Refer to Figure 13.3. Total power is the power that is present on the fiber. The total power measurement 
is displayed in dBm.

13.4 Channel AnalyzerTable

The table located in the bottom right of the display indicates power levels for the 8 CWDM channels, 
listed 1-8 with 1471nm being number one and 1611nm being number eight. The power level displayed is 
controlled by the Power soft key at the top right of the display. There are four options when displaying 
power. Show Power indicates the real time power of each channel. There are also Show Min, Show Max 
and Show Avg options. To select the desired power level to be show, press the Menu button, scroll to the 
Show XXX soft key and press Select to cycle through the four choices. These measurements are real 
time and accumulated during the length of a scan.
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13.5 Unit of Measure

The units of measure are wavelength or frequency. The Lambda icon is used to change the unit of 
measure between nanometers or terahertz. This will change the A-B span measurement to the left of the 
λ icon and the measurements displayed for each cursor. To change the unit of measure, enter the menu 
mode by pressing the Menu button and scrolling to the Lambda icon. Once highlighted, pressing the 
Select button will toggle between nanometers or terahertz. Press the Menu button again to return to the 
Scan Mode.

13.6 Quick Save/Recall

A scan may easily be stored to memory by using the Save soft key. To do this, enter the menu mode, 
scroll to the Save soft key and press the Select button. The scan will be saved to the location indicated. 
If that storage position is full, a dialog will be displayed with the options of overwriting the file, storing to 
the next available location or canceling the command. Use the scroll wheel to highlight the desired action 
and press Select. The action will be complete and the display will return to the scan mode.

Any file saved with this method will use the base file name of the last manually entered file and 
increments the suffix by one.

To use the quick Recall feature, enter the menu mode and scroll to the Recall soft key. Pressing the 
Select button will recall the scan stored in the indicated storage location. Continued selecting of recall 
will cycle through any stored scans and when the last stored scan is reached, continued selection will 
start back at the first occupied storage location. Press the Menu button to return to the scan mode.
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Chapter 14 Channel Analyzer File Management

14.0 File Management

The OSA has the capability to store up to 1000 scans. Once stored, these files may be copied to a PC 
via a USB cable or copied to a USB flash drive. To enter file management, press the Menu button, scroll 
to the File Management icon and press the select button. The files are listed in order of file storage 
position with an xxxxxxxx.OSA (8.3) naming convention. Use the Scroll Wheel to move from one stored 
scan to another. As a file is highlighted the time and date stamp are displayed with total and peak power 
information and the number of channels measured. There is also a preview map of the scan displayed.

Exit File
Management

Copy Files w/
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Copy Files
w/USB

Flash Port

Name/Rename  
File

Delete
File

Mark
File

Access
USB Flash

File Storage
Position

File
Name
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Fig 14.1
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14.2 Viewing a Store Scan

To view a scan that has been stored in the file management area, press the select button while the 
desired file is highlighted and the file will open in the scan mode.

14.3 File Management Soft Key Functions

Exit File Management
There are two methods to return to the scan screen from the file management area. First is to enter 
the menu mode, scroll to the Exit soft key and press select. The second is to press select while a file is 
highlighted, this will open the scan screen with the highlighted file displayed.

Copying Files to a Personal Computer
With the use of the supplied certification software and USB cable the stored files may be copied directly 
to a PC. Highlight or Mark (see Marking Files on the next page) the desired file/s to be copied and scroll 
to the Copy PC soft key. Press Select to move the files to the computer when directed to do so in the 
certification software.

Copying Files to Flash Drive
To Copy files to a flash drive, insert a flash drive (not to exceed 4Gbits in capacity) into the flash drive 
port. Highlight or Mark (see Marking Files on the next page) the desired file/s to be copied and scroll to 
the Copy USB soft key. Press Select to copy the files to the root directory of the flash drive.

Naming a File
The Name soft key may be used to name a file for a new scan to be saved or to rename a currently stored 
file. Files stored with the Save soft key will take the base name of the last named file. To start a new set 
of scans with a new base file name, enter the menu mode while the first scan is displayed. Scroll to the 
desired storage location for the first scan of the project. Press the Menu button, scroll to the Name soft 
key and press Select. The storage location will display a black box with a .OSA extension. Use the Scroll 
Wheel to cycle through the available characters. The available characters are (space), 0-9, A-Z and a-z. 
Press Select to enter the character and move to the next character. Once the desire file name is in place, 
press the Menu button and “Save Changes or Discard Changes” will be displayed in the soft key bar. 
Scroll to highlight Save Changes and press the Select button to complete the action.
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Tel: (888) 545-1254      •      Fax: (415) 358-4602      •      Email: Sales@PrecisionRatedOptics.com
www.PrecisionRatedOptics.com 46

Note
The file name is formatted as xxxxxxxx.OSA (8.3) style. The file storage system uses the eighth, 
seventh then the sixth position to make the file name unique with an identifier digit. Therefore 
depending on how many files need to be saved for the group of test, it may be best to only use 5, 
6 or 7 characters for the file name. For example: If a file name of bbbbbbb.OSA was give to the 
first scan, when the following scans are saved they will be named; bbbbbbb0.OSA , bbbbbbb1.OSA, 
bbbbbbb2.OSA and so on. In this case if there were more then eleven scans, the next name would 
be bbbbbb10.OSA. The name would be adjusted to accommodate the two digit identifier. With the 
storage capability of up to 1000 scans, the identifier could possibly use up to three positions. It is 
suggested that this be taken into consideration when creating the base file name.

Renaming a File
To rename a file, highlight the file to be renamed, press the Menu button and scroll to the Name soft 
key. Press select and the first character of the file name will be highlighted. Continue to name the file as 
described earlier, press menu when done to either save changes or discard changes.

Deleting Files
To delete files, Highlight the file or Mark files (see Marking Files below) to be deleted. Press the Menu 
button and scroll to the Del soft key. Press select and “Cancel or Confirm” delete will be displayed in the 
soft key bar. Use the scroll wheel to highlight the desired action and press Select.

Marking Files
Mass Copying and deleting can be accomplished with the Mark soft Key. Highlight the first file to be 
copied or deleted, press the Menu button, scroll to the Mark soft key and press Select. Use the scroll 
wheel to move through the files. Moving clockwise marks any files that are passed and move counter 
clockwise un-marks any files that are passed. Marked files will be displayed in red. Press the menu button 
again and select the desired soft key function to be completed.

Viewing Scans from a USB Flash Drive
The PRO-8CW-35SM can view files from a USB Flash drive. Insert the USB Flash drive into the proper 
port and enter the menu mode. Scroll to highlight the USB soft key and press the Select button. The PRO-
8CW-35SM will read any .OSA files in the root directory of the flash drive. Highlight the file to be viewed 
and press the Select button. To exit the flash drive directory, press the Select button a second time while 
the USB soft key is highlighted and the focus will revert back to the on board file management system.
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15.0 Video Scope

The PRO-8CW-35SM can accommodate PRO Video Probe. Located on the bottom panel is a an 8pin DIN 
connector labeled “Vid Probe” The PRO-8CW-35SM can view a connector end face, center the image and 
zoom from 200X to 400X. This feature is accessed from the Home screen.

15.1 Video Scope Display

Note
Only the Soft Keys 
and the Help Icon 
are accessible on the 
Video Probe display

15.2 Video Scope Operation

From startup, scroll to highlight the Scope icon and press select. If the instrument is in another 
application, press the Menu button, scroll to the Home or Exit icon and press Select to return to the 
Home screen. Insert the probe and turn on the probe light by moving the switch on the probe to the right. 
The LED will illuminate indicating the probe light is on. Insert a connector to the probe or insert the probe 
into a fiber adapters and focus. Use the thumb wheel to focus the image. To zoom to 400X, press the 
Zoom button. Pressing the Zoom button again will revert back to 200x.

Chapter 15 Video Scope Operation
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Chapter 15 Video Scope Operation

15.3 Video Scope Soft Keys

To access the Soft Keys, press the Menu button and use the scroll wheel to highlight the desired Key.

Home
Used to return to the Home Screen

Copy
To copy or delete images, Press the Menu button and scroll to the Copy soft key. Pressing select on the 
soft key will display a dialog that offers the option of coping all of the images to the PC via the USB/PC 
port or to a flash drive. The dialog will also offer the option to delete all the stored video files or cancel 
the process. Scroll to the desired action and press the Select button.

Note
Do Not Remove USB Flash Drive While Accessing.

Save
The Video image may be saved as a Bitmap by pressing the Menu button, scrolling to the Save soft key 
and pressing the Select button. This will attempt to save the image to the location displayed next to 
the Save soft key. If that location is occupied by a stored image, a dialog will appear with the choice to 
overwrite that location, save to the next available location or cancel the process. Scroll to the desired 
action and press the Select button.

Recall
To view a stored image, scroll to the Load soft key and press select to view the image at the indicated 
location. Subsequent presses of the Select button will increment through the occupied storage locations.

Adjust Position/Adjust Contrast
This soft key is a toggle between adjust Positon and Adjust Contrast. With Adjust Position soft key 
is shown, the image may be centered by use of the scroll wheel when in the 400X zoom setting. For 
positioning, use the scroll wheel as a left-right-up-down feature by pressing those areas of the wheel. 
With Adjust Contrast soft displayed, the scroll wheel will change the contrast of the image.
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Chapter 16 Visible Fault Locator

16.0 Visible Fault Locator (VFL)

WARNING
Never clean or look directly into the fiber optic connector or the end of fiber attached to the OTDR or 
VFL unit while they are energized, to do so will expose the user to laser radiation and could result in 
personal injury or instrument damage.

16.1 VFL Description

Visible Fault Locator Description
The Visible Fault Locator (VFL) is a stabilized fiber optic laser source that emits visible (red) light at 
650nm. Its intended function is to allow an operator to identify fibers or find the exact location of a break, 
micro bend, or other discontinuity in a fiber optic cable. As the radiation is visible, light emanating from a 
break or micro bend enables the user to locate the exact position of a fault even at very short distances 
that would not be detectable by other means. It is also useful for identifying a particular fiber in a cable 
by exciting the fiber to be located with visible radiation.

16.2 VFL Operation

Visible Fault Locator Operation
This feature is accessed from the Home screen. From startup, scroll to highlight the VFL icon and press 
select to cycle through VFL through CW (constant wave) mode or MOD (modulated) mode and Off. If the 
instrument is in OTDR or LTS mode, press the Menu button, scroll to the Exit icon and press Select to 
return to the Home screen. When in the Video Probe mode scroll to the Exit soft key and press Select to 
return to the home screen.

Note
When in the OTDR application and the VFL is required, the active trace will not be lost by exiting to 
the home menu.
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Chapter 17 Maintenance

17.0 Maintenance

17.1 Battery Replacement

Battery replacement is not recommended; however, if you must replace the batteries, follow this procedure. 
Unplug external power supply and ensure the unit is turned off. Carefully remove unit from protective boot 
and remove the two screws from top plate and bottom plates that retain the back cover. Carefully remove back 
cover and remove the two screws that hold the battery covers in place. Replace only with 8 high quality AA NiMH 
batteries. Do not use batteries that are rated at less the 2500mAh. If you install NiMH batteries that are dead or 
less than 1 volt each, charge these batteries for one (1) hour before using this unit.

Warning
To Prevent Fire or Shock Hazard:

● Do not install battery types other than those specified by the manufacturer
● Do not use the charger without the batteries installed
● Do not expose the battery charger to rain or excessive moisture
● Do not use the AC adapter when there are signs of damage to the enclosure or cord
● Ensure that you are using the correct charger for the local line voltage
● Do not use any other charger than the one provided with this instrument.

Failure to follow these caution statements may void the warranty of this equipment.

Note
For maintenance, batteries require a monthly recharge

17.2 Calibration and Verification

Periodic verification of the PRO-8CW-35SM is recommended to ensure that your instrument remains within 
specification. Although not imperative, we recommend a calibration and verification once a year to make certain 
the instrument is functioning properly and performing to its rated specifications. Consult the factory for service.

17.3 Adapter Replacement

The PRO-8CW-35SM is supplied with two easily interchangeable adapters per port, SC/FC. To change an adapter, 
remove the two screws that hold the adapter in place, pull the adapter straight up from ferrule. It is suggested that 
you clean the exposed ferrule with appropriate cleanser and lint free wipe anytime you replace the ferrule.

Note
In order to maintain a low loss fiber connection, care should be taken to adequately clean the ferrule of 
any connector to be connected to the OSA. In the event that the port needs to be cleaned, first step is to be 
certain the instrument is off. We suggest the use of isopropyl alcohol and foam swabs specifically designed for 
cleaning connectors accepting 2.5mm ferrules.

Note
When replacing the adapter with one that does not have a chained protective cap, use the small screw in place 
of the larger screw that retains the end of the chain to the adapter base.
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Chapter 18 Specifications

OTDR  

Wavelength 1310, 1550 nm

Dynamic Range 36 / 34 dB (SM)

Pulse Width 5 ~ 20,000 ns

Units of Measurement km, kf, mi 

Event Dead Zone 1m

Attenuation Dead Zone 4m

Resolution .125 ~ 32m

Distance Measurements ± (0.75m + 0.005% x distance + sampling resolution)

Full-Distance Accuracy Range 1-180km Singlemode

Typical Real-Time Refresh Rate 2 Hz

Group Index of Refraction (GIR) 1.024  -  2.048

Linearity ± .05 dB/dB

Connector Styles FC, ST, SC Interchangeable

Memory Capacity 500 Traces

Visible Light Source

Emitter Type
Laser Photo Diode  

1100 ~ 1700nm InGaAs-70 ~ +9dBm  
with Interchangeable FC Adaptor

Wavelength 650nm (±5nm)

Connector Type 2.5mm Universal

Output Power 1mW Max.

Power Meter Specifications 

Detector Type InGaAs

Connector Types FC, ST and SC

Dynamic Range +5 ~ -77dB (CATV  +25 ~ -57dB)

Calibrated Wavelengths 850,1300,1310,1490,1550,1625nm

Units of Measurement dBm, dB

Resolution .01 dB

Power Measurement Uncertainty ± 0.18 dB (under reference conditions), ± 0.25 dB from 0 ~ -65 dBm, ± 0.35 dB from 0 ~ +5 dBm and from -65 ~ -77 dBm

Auto Test Range 0 ~ -40dB

Light Source Specifications 

Fiber Type SM/MM

Wavelengths 850, 1300, 1310, 1550 nm (±20nm)

Output Power 0 dBm  (-3dBm @ 1550nm)

Laser Safety  
Classification Class I Safety Per FDA/CDRH and IEC-825-1 Regulation

Modulation Modes CW, 270 Hz, 1,000 Hz, 2000 Hz 

CWDM Channel Analyzer

Wavelength Range 8-Channel 1471 ~ 1611nm

Channel Spacing 20nm

Channel Pass Band ±6.5nm

Channel Power Range +5dBm ~ -50dBm

Absolute Accuracy ±1 dB

Max Composite Power +23dBm

PDL ±0.2dB

Adjacent Channel Isolation 30dB

Measurement Time < 1/2 Second

Readout Resolution 0.01dB

Return Loss >40dB

Optical Interface Universal UPC (FC/SC)

Graphical Display Bar Graph and Table View

Memory Capacity 1,000 Scans
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Chapter 19 Warranty and Repair

19.1 Warranty Information

This product, including all mechanical, electrical, and optical parts and assemblies are unconditionally 
warranted to be free of defects in workmanship and material for a period of one (1) year from the date 
of delivery. 

This warranty does not apply to expendable parts such as batteries or optical panel connectors, nor 
to any instrument or component which has been subjected to misuse, alteration, or fiber connector 
damage. It is the customer’s responsibility to understand all the instructions and specifications prior 
to operating this instrument. This warranty does not extend to any loss or damage consequent to the 
failure of the warranted product.

19.2 Repair Information

If repair is required, simply call the factory for return instructions and a RMA number.
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Chapter 20 Trouble Shooting Guide

Symptom Possible Cause Solution

LCD dark

Power not on Press ON/OFF key

Batteries require recharging Recharge batteries

Batteries are missing, in backwards  
or need replacement

Check polarity, replace batteries, or contact 
factory for servicing

LCD white Power cycled too quickly Turn off wait 10 seconds - turn on

Instrument locked Up Unexpected Operational Mode
Turn off (hold ON/OFF button in for 1 second) 
wait 10 seconds - then depress On/Off again 

button to turn the unit on.

Activity indicator does not change 
to standby or active mode Power cycled too quickly Turn off wait 10 seconds - turn on

Low or no power being displayed

Defective cord or dirty connector Replace or clean cord

Fiber Output port requires cleaning Clean and inspect port

Angle polish mated with UPC polish Examine connector ends for damage.  
Use UPC Connectors ONLY

USB hookup to PC  
not functioning properly

USB baud rate not set properly  
or too quick for computer

Set port baud rate properly or decrease Baud 
rate in instrument and certification software

PC drivers not set properly Un-install & re-install certification  
software and drivers

USB Flash Driver  
not functioning properly

USB flash drive full Clean or use a new flash drive

USB flash driver cycled too quickly Turn power off wait 5 seconds turn back on
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Chapter 21 Version Control

19.0 Version Control

Through a program of continuous improvement the upgrade of the features and performance of 
this instrument are an ongoing process. The version is displayed on Home Screen in the lower right 
hand corner of the display. The version changes and approximate release dates are as follows.

V0.2 - 7/2012 - Initial release date



Precision Rated Optics, Inc. 
Corporate Office

Billing & Processing
PO Box 877    Trexlertown, PA 18087

Precision Rated Optics, Inc. 
Product Distribution Center 

Manufacturing & Testing
9999 Hamilton Blvd

Breinigsville, PA 18031


